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The Implicit Association Test (IAT, Greenwald, McGhee, 
& Schwartz, 1998) is the most popular procedure for 
measuring automatic associations. Since its appearance, 
the IAT has received significant attention as an effective 
tool for the investigation of implicit social cognitions, 
including attitudes (Greenwald, Smith, Sriram, Bar-
Anan, & Nosek, 2009; Maison, Greenwald, & Bruin, 
2004; Uhlmann, Dasgupta, Elgueta, Greenwald, & 
Swanson, 2002), stereotypes (Cvencek, Meltzoff, & 
Greenwald, 2011; Nosek, Banaji, & Greenwald, 2002; 
White & White, 2006) and self-concept (Schnabel, 
Asendorpf, & Greenwald, 2008; Steffens & Schulze 
König, 2006; Yamaguchi et al., 2007).

The discrimination-association model (DAM, 
Stefanutti, Robusto, Vianello, & Anselmi, 2013) is a 
stochastic model for the analysis of reaction time and 
accuracy of an individual respondent to the IAT. 
Specific features of the model make it a useful tool for 
the analysis of IAT data. Since the DAM accounts for 
both response time and accuracy, it uses the complete 
information provided by the IAT. The DAM disentan-
gles the influences of three qualitatively different 
components on the responses to the IAT: stimuli discrim-
ination, automatic association, and termination crite-
rion. These components have interesting interpretation 
and allow for substantive insights about the response 
process. In particular, termination criterion informs 

about task difficulty and individual cautiousness, 
stimuli discrimination informs about the functioning 
of the stimuli, automatic association informs about the 
association between targets and attributes. Applications 
of the DAM to empirical data have shown that the 
model enables a fine-grained analysis of the IAT 
(Anselmi, Vianello, Stefanutti, & Robusto, 2013; Stefanutti 
et al., 2013).

This article presents General Race (GRace), a MATLAB-
based application for fitting the DAM to IAT data. 
GRace is user-friendly, and does not require any pro-
gramming experience.

The next sections (1) briefly describe the IAT and 
(2) the DAM, (3) illustrate the use of GRace on the data 
of a Coca Cola-Pepsi Cola IAT, and (4) interpret and 
discuss the results of the analysis. Details about the DAM 
and the fitting procedure can be found in Stefanutti 
et al. (2013).

Implicit Association Test

The IAT is a computerized two-choice discrimination 
task. A pair of target categories (e.g., Coca Cola and 
Pepsi Cola) and a pair of attribute categories (e.g., Good 
and Bad) are displayed at the top-left and top-right 
screen corners. Stimuli representing each of the cate-
gories appear, one at a time, in the center of the com-
puter screen, and participants have to categorize them 
into one of the categories by pressing, as quickly and 
accurately as possible, one of two response keys.

The IAT consists of seven blocks. Block 1 involves the 
categorization of stimuli representing the target cate-
gories, whereas Block 2 involves the categorization of 
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stimuli representing the attribute categories. Block 3 
involves the categorization of stimuli representing the 
target categories and stimuli representing the attribute 
categories, with a certain target-attribute pairing. For 
example, the categories Coca Cola and Good share a 
response key, and the categories Pepsi Cola and Bad share 
the other. Block 4 repeats this task with an additional 
set of trials. Block 5 repeats the task of Block 2, with a 
reversed position of the attribute categories on the screen. 
Blocks 6 and 7 reverse the target-attribute pairing of 
Blocks 3 and 4, so that the categories Coca Cola and Bad 
share a response key, and the categories Pepsi Cola and 
Good share the other (Blocks 3 and 4 are counterbalanced 
across participants with Blocks 6 and 7). Blocks 1, 2 and 5 
are called practice blocks, whereas Blocks 3, 4, 6 and 7 are 
referred to as critical blocks. The target-attribute pairing 
that leads to faster and more accurate responses is called 
compatible, whereas the other is called incompatible.

Discrimination-Association Model

The DAM assumes that, when a stimulus is presented 
on the computer screen, the response of the participant 
is governed by four parallel and independent pro-
cesses, one for each category of the IAT. In the Coca 
Cola-Pepsi Cola IAT at hand, these processes are 
denoted as XC(t), XP(t), XG(t), and XB(t), where C = Coca 
Cola, P = Pepsi Cola, G = Good, and B = Bad. Model 
assumptions are that every stimulus potentially con-
tains - albeit in a variable quantity - evidence for each 
of the four categories, and that it is simultaneusly and 
independently processed by each of the four processes. 
Once a stimulus is presented on the screen, each pro-
cess starts accumulating, on its own counter, selective 
information about a specific characteristic of it (for 
instance, process XC(t) accumulates information about 
the membership of the stimulus to category Coca Cola). 
The process which accrues the required amount of in-
formation (called termination criterion) in the shortest 
time produces the observable response. The four pro-
cesses are assumed to behave as Poisson processes. 
This implies that, in each process, interarrival times 
(i.e., time intervals between consecutive units of infor-
mation) are independent and exponentially distrib-
uted with rate λ (see, e.g., Townsend & Ashby, 1983).

Model parameters are the rates at which information 
accumulates on the counter of each process, and the 
termination criteria. There are 16 different rates (λ 
parameters), one for each pair that can be formed by 
taking one of the four processes and one of the four 
categories. For i, j ∈ {C, P, G, B}, the parameter λi→j is the 
average amount of information provided, in the time 
unit, by a stimulus of category i to process Xj(t). The 
16 rates can be grouped into discrimination rates and 
association rates.

The discrimination rates regard the amount of infor-
mation that target (respectively attribute) categories 
accumulate when target (resp. attribute) stimuli are 
presented. The rates λC→C, λP→P, λG→G, λB→B are involved 
in the correct discrimination of the stimuli, whereas 
the rates λC→P, λP→C, λG→B, λB→G are involved in the 
incorrect discrimination. The discrimination rates pro-
vide information about stimuli discrimination, that is, 
whether the stimuli that have been chosen to represent 
a certain category are easily recognized and correctly 
categorized in their own category, rather than incor-
rectly categorized in the contrasted category. The better 
the discrimination, the smaller the incorrect discrimi-
nation rates compared with the correct discrimination 
rates. In a Flowers-Insects IAT, for example, the ratio 
between correct and incorrect discrimination rates of 
category Flowers is expected to be larger if the words 
used for representing the category refer to familiar 
flowers (e.g., rose and tulip) than if they refer to unfa-
miliar flowers (e.g., hydrangea and zephyranth).

The association rates regard the amount of informa-
tion that target (resp. attribute) categories accumulate 
when attribute (resp. target) stimuli are presented. In 
particular, λC→G, λC→B, λP→G, λP→B are the rates at which 
information concerning membership to attribute cate-
gories is accumulated when a target stimulus is pre-
sented (target-driven associations), and λG→C, λG→P, λB→C, 
λB→P are the rates at which information concerning 
membership to target categories is accumulated when 
an attribute stimulus is presented (attribute-driven 
associations). The association rates express the amount 
of information that targets (resp. attributes) provide 
about attributes (resp. targets) and, in this sense, they 
can be seen as an expression of the association strenght 
between targets and attributes. The stronger the associ-
ation, the greater the value of these parameters.

In practical applications of the model, the associa-
tion rates might allow the identification of patterns of 
automatic association between targets and attributes that 
differ from one individual to another in both structure 
and meaning. For example, in the Coca Cola-Pepsi 
Cola IAT at hand, the association rates might allow the 
distinction between individuals whose implicit prefer-
ence for a certain cola results from a positive evalua-
tion of that cola from those whose implicit preference 
results from a negative evaluation of the constrasting 
cola. In a White-Black IAT, they might allow the dis-
tinction between individuals with an implicit outgroup 
derogation (e.g., Black-Bad association in a white par-
ticipant) and individuals with an implicit ingroup 
favouritism (e.g., White-Good association in a white 
participant).

The termination criteria concern the amount of in-
formation that has to be accumulated before a response 
is given. Individuals are more cautious to the extent 
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they perceive a block of trials as difficult (Brendl, 
Markman, & Messner, 2001). The practice blocks involve 
the categorization of stimuli representing either the 
target categories or the attribute categories, whereas 
the critical blocks involve the categorization of stimuli 
representing the target categories and stimuli repre-
senting the attribute categories. As a consequence, the 
critical blocks are expected to be more difficult than the 
practice blocks. The critical blocks might differ in diffi-
culty. For instance, an individual with a close associa-
tion between Flowers and Good will find it easier to 
respond when Flowers shares the response key with 
Good than when it shares the response key with Bad. 
An incorrect response is expected to be the effect of 
carelessness or inattention. Therefore, the termination 
criteria of the wrong responses are expected to be 
lower than those of the correct responses.

The termination criteria may be the combined result 
of individual cautiousness, task difficulty, and their inter-
action. There are 6 termination criteria (K parameters), 

one for each pair that can be formed by considering a 
particular type of block (practice, compatible, incom-
patible) and a response category (correct, wrong).

GRace

GRace (availabe upon request from the corresponding 
author) is a free standalone application developed in 
MATLAB for Windows. The users of GRace will be 
provided with detailed information and instructions 
about the application.

It is possible to open the data file that has to be ana-
lyzed by selecting “Open data” from the “File” menu. 
MATLAB files (.mat), EXCEL files (.xls, .xlsx), and tab-
delimited text files (.txt) are accepted. The data file 
should provide trials in rows and the following vari-
ables in columns: (1) participant code, (2) block code, 
(3) trial code, (4) response accuracy (0 = wrong,  
1 = correct), and (5) response time in milliseconds (see 
Figure 1 for an example). In the IAT, the built-in error 
correction is typically used to inflate the latencies of 

Figure 1. Screenshoot of the data and selection of the participants who have to be analyzed.
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Figure 2. Classification of the block codes as practice, compatible and incompatible.

the wrong responses with the time elapsed to correct 
them. The DAM applies to latencies without correction.

The “Participants selection” listbox (Figure 1) dis-
plays the codes of all participants that are present in 
the data file. It is possible to fit the DAM on subsets of 
participants by selecting their codes from this listbox. 
In our example, participant 1175 is selected. The histo-
gram in Figure 1 depicts the response time distribution 
of the selected participant.

After this preliminary operation, it is necessary to 
specify and classify blocks and trials in the data file. 
Information about the blocks is provided by selecting 
“Classify block codes” from the “Data” menu. The 
“Available Block Codes” listbox (Figure 2) displays the 
codes that identify the different IAT blocks in the data 
file. Each block code is selected from the listbox and 
classified as practice, compatible or incompatible 
block. In our example, “Coca/Pepsi”, “Bad/Good” 
and “Pepsi/Cola” are classified as practice blocks, 
“PepsiBad/CocaGood” and “PepsiBad/CocaGood_2” 

as compatible blocks, and “CocaBad/PepsiGood” and 
“CocaBad/PepsiGood_2” as incompatible blocks. 
Please note that, at this stage (i.e., before the data are 
analyzed), the distinction between compatible and 
incompatible blocks only reflects a conventional 
classification and will only affect the interpretation of 
the output.

Information about the trials is provided by selecting 
“Classify trial codes” from the “Data” menu. The list-
box on the left displays the codes that identify the trials 
in the data file (Figure 3). Each trial code is selected 
from the listbox and classified into one of the four 
stimulus categories. In our example, “CocaLeft” and 
“CocaRight” are classified as Target 1, “PepsiLeft” and 
“PepsiRight” as Target 2, “GoodRight” as Attribute 1 
and “BadLeft” as Attribute 2.

At this point, it is possible to fit the DAM by selecting 
“Fit” from the “Model” menu. Maximum likelihood 
estimation of model parameters is accomplished by 
the BFGS optimization algorithm (Broyden, 1970; 
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Fletcher, 1970; Goldfarb, 1970; Shanno, 1970), an itera-
tive procedure that terminates when one of the fol-
lowing two conditions is reached and satisfited: (1) the 
maximum number of iterations is exceeded, or (2) the 
decrease of log-likelihood in two successive iterations 
is less than a sufficiently small tolerance value. By 
default, the two criteria are respectively set to 10,000 
and 10−6. By default, model parameters are estimated 
only once on the same data, and trials whose latencies 
are outliers in the response time distribution are  
discarded according to Tukey’s criterion (see, e.g., 
Hoaglin, Mosteller, & Tukey, 1983). All these default 
settings can be modified by selecting “Options” from 
the “Model” menu. In particular, estimating model pa-
rameters more than once is useful in an attempt to 
avoid local maxima. Only the solution with the largest 
likelihood is retained and displayed in the output file.

The output of GRace

The first part of the output (Figure 4) reports the per-
centage of trials discarded from the analysis (if outlier 
deletion has been applied) and a number of indices 
and statistics concerning the fitting procedure (infor-
mation about the meaning of the indices is also pro-
vided). As a goodness-of-fit index of the DAM, a 
Pearson’s Chi-square statistic is computed, that is 
based on the procedure described by Klauer, Voss, 
Schmitz, & Teige-Mocigemba (2007). In our example, 
we can see that the model adequately fits the data of 
the participant at hand (χ2(39) = 33.61, p = .71).

The following part of the output reports the esti-
mates of the λ parameters. The labels on the left of the 
arrow denote the stimulus category, whereas the labels 
on the right denote the process. It is worth recalling 
that, in the present example, Target 1, Target 2, Attribute 1 

and Attribute 2 respectively denote Coca Cola, Pepsi 
Cola, Good and Bad.

The first eight λ parameters are discrimination 
rates. For each stimulus category, the rate concerning 
the correct discrimination was greater than that con-
cerning the incorrect discrimination (λTarget1→Target1 > 
λTarget1→Target2; λTarget2→Target2 > λTarget2→Target1; λAttrib.1→Attrib.1 
> λAttrib.1→Attrib.2; λAttrib.2→Attrib.2 > λAttrib.2→Attrib.1; the 
parameters can be standardized and their statistical 
difference can be tested). The stimuli provided, in the 
time unit, more information towards the correct response 
than towards the incorrect response. This means that 
the participant at hand easily recognized the stimuli and 
categorized them into the correct category.

The last eight λ parameters are association rates. The 
target-driven association rates are considered first. The 
Coca Cola stimuli provided, in the time unit, more in-
formation towards the category Good than towards the 
category Bad (λTarget1→Attrib.1 > λTarget1→Attrib.2), whereas 
the Pepsi Cola stimuli provided more information 
towards the category Bad than towards the category 
Good (λTarget2→Attrib.2 > λTarget2→Attrib.1). Accumulation 
of information about the category Good was faster 
when the stimuli were Coca Cola and slower when the 
stimuli were Pepsi Cola (λTarget1→Attrib.1 > λTarget2→Attrib.1). 
Accumulation of information about the category Bad 
was faster when the stimuli were Pepsi Cola and slower 
when the stimuli were Coca Cola (λTarget2→Attrib.2 > 
λTarget1→Attrib.2). The same pattern of results is obtained 
by considering the attribute-driven association rates. 
In this participant, an implicit preference for Coca Cola 
relative to Pepsi Cola is observed, that resulted from 
both a positive evaluation of the Coca Cola and a nega-
tive evaluation of the Pepsi Cola. Different patterns of 
automatic association have been described, in which 

Figure 3. Classification of the trial codes as Target 1, Target 2, Attribute 1 and Attribute 2.
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the preference for a certain cola either resulted only 
from a positive evaluation of that cola or resulted only 
from a negative evaluation of the contrasted cola 
(Stefanutti et al., 2013).

The standard errors of two λ parameters are very 
large. A possible explanation is that the data at hand 
are not sufficiently informative for computing reliable 
estimates of the two parameters. Empirical nonidenti-
fication of one or more parameters might occur even if 
the model is identifiable in theory (see Stefanutti et al., 
2013). Another possible explanation is that the true 
values of the two parameters are on or too close to the 
boundary value of 0.

The last part of the output reports the estimates of 
the K parameters. It is worth recalling that, in the pre-
sent example, the label compatible denotes the Pepsi 

Cola-Bad/Coca Cola-Good blocks and the label incompat-
ible denotes the Coca Cola-Bad/Pepsi Cola-Good blocks. 
For the participant at hand, the Pepsi Cola-Bad/Coca 
Cola-Good blocks were more difficult than the practice 
blocks and less difficult than the Coca Cola-Bad/Pepsi 
Cola-Good blocks (KPractice < KCompatible < KIncompatible). 
This holds for both the correct responses and the incor-
rect responses.

Conclusions

The article presented GRace, a MATLAB-based appli-
cation for fitting the DAM to IAT data. The use of 
GRace has been illustrated on the data of a Coca Cola-
Pepsi Cola IAT, and the results of the analysis have 
been interpreted and discussed.

Figure 4. The output of Grace.
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Grace is constantly under development. Current 
work is devoted to allow users to impose equality con-
straints between the parameters, and to provide them 
with a formal test of the empirical identifiability of the 
parameters (for details, see Stefanutti et al., 2013). 
Theoretical extensions of the DAM are under develop-
ment that incorporate nondecision components (e.g., 
encoding stimuli, motor response, distractions) within 
the model, and that allow for variability of rates and 
termination criteria within the blocks.
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